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KATA PENGANTAR 

 

 

Tugas Akhir adalah suatu karya tulis ilmiah berupa paparan tulisan hasil penelitian 

mahasiswa Diploma Tiga, dimana mahasiswa akan memadukan pengetahuan dan 

keterampilannya dalam memahami, menganalisis, menggambarkan, dan menjelaskan suatu 

permasalahan berdasarkan penelitian yang dilakukan. Penyusunan Tugas akhir merupakan 

persyaratan yang wajib diikuti oleh mahasiswa untuk memperoleh gelar Ahli Madya 

Komputer (A.Md.Kom) pada program pendidikan vokasi Program Studi Manajemen 

Informatika dan Teknik Komputer STMIK Triguna Dharma. 

Untuk mempermudah mahasiswa dalam menyusun Tugas Akhir maka diberikan 

buku panduan ini, yang berisi sistematika penulisan, tahapan-tahapan, aturan-aturan dan 

bentuk penyusunan maupun format penulisan Tugas Akhir. Panduan ini ditujukan untuk 

keseragaman dalam penulisan Tugas Akhir dan sebagai acuan bagi mahasiswa dan 

pembimbingnya dalam penyusunan Tugas Akhir. 

Dengan adanya panduan ini maka diharapkan kepada mahasiswa untuk membaca, 

mempelajari dan mengikuti arahan yang diberikan, sehingga Tugas Akhir dapat 

diselesaikan dengan sukses. Jika terdapat kesulitan dalam memahami panduan ini maka 

diharapkan untuk segera menghubungi ketua program studi. Semoga panduan dapat 

bermanfaat bagi kita semua dan mampu mempermudah mahasiswa dalam 

menyelesaikan Tugas Akhirnya. Selamat menyusun Tugas Akhir. 

 

 

 
Medan, Juni 2023 

Penyusun, 

 
 

dto 

 

Ketua Program Studi Vokasi 

STMIK Triguna Dharma 
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KETENTUAN UMUM 

 

 

1. Parameter Penilaian Tugas Akhir 

Penilaian Tugas Akhir dilakukan pada saat pelaksanaan Seminar Proposal (Project 1), 

Seminar Hasil (Project 2) dan Ujian Komprehensif (Tugas Akhir). Berikut ini 

merupakan parameter penilaian Tugas Akhir : 

 

No Parameter Cakupan 

Standar Penilaian : Teknik Penulisan (10%) 

1 Ketatabahasaan 

Kesesuaian kaidah antar kalimat maupun paragraf  

Kesesuaian penggunaan kalimat (kata ganti, struktur 
kalimat, dan iterasi bahasa) 

Penggunaan kata atau kalimat baku sesuai dengan KBBI 

Kemampuan menggunakan parafrase dengan batas 
maksimal plagiat sebesar 40% 

Kesesuaian penulisan istilah asing 

2 Kutipan 

Kesesuaian referensi dengan topik pembahasan skripsi 

Ketersediaan jumlah referensi minimal 12 

Keterbaharuan referensi minimal 5 tahun terakhir 

Susunan sub bab dengan konteks  pembahasan/penelitian 

Kesesuaian daftar pustaka mengikuti format IEEE 

3 Pengelolaan Dokumen 

Kesesuaian tata kelola dokumen skripsi (spasi, margin, 
header, footer, tabulasi, jenis dan size kertas)  

Kesesuaian dan kejelasan penulisan tabel, halaman dan 
gambar 

Kerapian penulisan sesuai dengan format penulisan skripsi 

Standar Penilaian : Etika (10%) 

1 Personalisasi 

Kerapian pakaian sesuai dengan ketentuan panduan 
skripsi 

Kelengkapan perangkat dalam pelaksanaan seminar dan 
sidang (laptop, charger, spidol dan peralatan 
pendukungnya yang dibutuhkan) 

Menjaga Sopan dan Santun serta mengikuti prosedur yang 
disampaikan oleh Moderator atau Panitia 

2 Komunikasi 

Kemampuan untuk menyampaikan sapaan pembuka dan 
penutup dengan baik 

Kemampuan berkomunikasi dengan baik dengan 
menggunakan tata bahasa yang mudah dipahami 

Menyampaikan argumentasi dengan baik dan tidak 
memperdebat penguji/pembanding dengan kasar 

Standar Penilaian : Bobot Ilmiah (30%) 

1 Pembahasan 

Judul skripsi bersifat original dan tidak terindikasi plagiat  

Kesesuaian antara Rumusan Masalah, Tujuan Penelitian, 
Dan Kesimpulan  

Kesesuaian landasan teori dengan pemaparan isi skripsi 
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Adanya inovasi atau dampak yang berikan dari hasil riset 
yang dilakukan 

2 Metodologi 

Ketepatan penggunaan metode yang digunakan dalam 
menyelesaikan kasus yang diangkat 

Kesesuaian pemaparan metode/algoritma yang digunakan 
sesuai dengan landasan teoritis (sumber referensi) yang 
digunakan 

Ketersediaan sumber data yang valid dan dapat diolah 
sesuai dengan judul yang diangkat 

Batasan Masalah yang di bahas mencerminkan cakupan 
pembahasan isi skripsi  

3 
Perancangan dan 

Pengujian 

Kesesuaian perancangan sistem dengan kebutuhan 
analisa sistem yang akan dibangun 

Kesesuaian perancangan sistem/aplikasi dengan hasil 
yang telah dibangun 

Kesesuaian antara Activity Diagram dan Use Case 
Diagram atau pemodelan lainnya  terhadap pola interaksi 
dengan perangkat lunak yang dibangun 

Kesesuaian Class diagram dengan Perancangan Basis 
Data Pada perangkat Lunak yang menggunakan database 

Standar Penilaian : Penguasaan Materi (50%) 

1 Topik Bahasan 

Kemampuan menyajikan materi dalam bentuk presentasi 
yang jelas dan mencakup pembahasan skripsi  

Kemampuan menjelaskan topik pembahasan skripsi 
(pentingnya mengambil judul, alasan pemilihan metode, 
studi kasus dan hasil yang diperoleh) 

Kemampuan menjelaskan analisa (algoritma/metode 
penyelesaian)  terhadap kasus yang diangkat 

Kemampuan menjelaskan kerangka kerja berserta 
tahapan-tahapan yang dilakukan dalam penyelesaian 
kasus yang diangkat 

Kemampuan menguasai teori bahasan (objek, referensi 
dan studi kasus penelitian) 

Kemampuan memberikan contoh  kasus dan penyelesaian 
sederhana dengan Metode Penyelesaian Yang Digunakan  

2 Pemodelan Sistem 

Kemampuan menjelaskan pemodelan sistem yang 
dirancang 

Kemampuan menjelaskan tentang fungsi symbol atau 
bentuk pemodelan sistem yang digunakan 

Kemampuan menjelaskan tentang perancangan sistem 
yang dibangun telah sesuai dengan analisis kebutuhan  

3 Demo Program 

Kemampuan menjelaskan penggunaan dan 
mendemonstrasikan sistem/aplikasi yang dibangun 

Kemampuan menjelaskan kebutuhan sistem meliputi : 
aplikasi yang digunakan untuk membangun perangkat 
lunak dan penggunaan jenis database 

Kemampuan menjelaskan tabel yang tercantum dalam 
database sesuai dengan kebutuhan sistem 

Ketersediaannya aplikasi yang telah berjalan dengan baik 
dan sesuai dengan perancangan sistem 
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Kemampuan menjelaskan fungsi koding pada aplikasi 
yang dibangun 

Kemampuan mempresentasikan akuisisi atau membuat 
program sederhana minimal memenuhi struktur koding 
dasar (aritmatika, kondisi, action) 

 

2. Bimbingan Tugas Akhir 

Dalam menyusun tugas akhir, mahasiswa dibimbing oleh 1 orang Dosen Pembimbing.  

1. Dosen Pembimbing bertugas memeriksa dan membimbing Tugas Akhir yang berkaitan 

dengan isi (konseptual, plagiasi dan penulisan) agar mahasiswa dapat menghasilkan Tugas 

Akhir dengan sebaik-baiknya. 

2. Pada proses bimbingan penyusunan Tugas Akhir : 

a. Mahasiswa wajib membawa Buku Panduan Tugas Akhir, dan berkas pendukung. 

b. Dapat dilakukan secara luring (tatap muka). 

3. Pembimbing wajib mengisi berita acara bimbingan secara terperinci dan jelas, sesuai 

dengan konteks isi koreksi yang dilakukan. 

Contoh  yang SALAH 
No 

Tanggal 

Pertemuan 
Topik Bahasan Keterangan 

Paraf Dosen 

Pembimbing 

 

1 

 

2 

 

3 

 

08/08/2023 

 

10/08/2023 

 

12/08/2023 

 

BAB I 

 

BAB I 

 

BAB II 

 

Revisi 

 

ACC 1 

 

Revisi 

 

 
 

 
 

 

 
 

 

Contoh yang BENAR 
No 

Tanggal 

Pertemuan 
Topik Bahasan Keterangan 

Paraf Dosen 

Pembimbing 

 

1 

 

 

2 

 

3 

 

08/08/2023 

 

 

10/08/2023 

 

12/08/2023 

 

BAB I : Perbaiki latar belakang masalah, 

Kosa kata dan margin 

 

Lanjut BAB II 

 

BAB II : Referensi jelas, penulisan 

kutipan, Istilah asing 

 

Revisi 

 

 

ACC 1 

 

Revisi 
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4. Dalam penyusunan Tugas Akhir, mahasiswa wajib menyertakan/memiliki sumber 

referensi (literatur) minimal 12 referensi (5 Tahun Terakhir) meliputi Jurnal Nasional, 

Proseding, Buku, dan Website imiah (Google Scholar) atau dari lembaga/instansi 

resmi. 

5. Mahasiswa wajib mencetak hasil plagiasi Tugas Akhir menggunakan aplikasi 

Plagiarism Checker X untuk pendaftaran Seminar Hasil dengan persentase Plagiat 

Tugas Akhir (All Bab) ≤ 40%, disarankan agar pengecekan plagiasi/similarity 

dilakukan setiap BAB pada saat proses bimbingan. Institusi menyediakan aplikasi 

tersebut sebanyak 6 buah di perpustakaan. 

6. Ketentuan Tugas Akhir Program Studi Manajemen Informatika : 

a. Membangun Sistem Informasi atau Aplikasi untuk menyelesaikan studi kasus 

tertentu. 

b. Sistem Informasi atau Aplikasi yang dibangun berbasis Dekstop, Web, Animasi dan 

Mobile. 

c. Pemodelan Sistem yang digunakan yaitu Data Flow Diagram (DFD) dan Unified 

Modelling Language (UML) tergantung data dari sistem atau aplikasi yang 

dibangun (dapat didiskusikan dengan pembimbing). 

7. Ketentuan Tugas Akhir Program Studi Teknik Komputer : 

a. Membangun sebuah prototype alat menggunakan Arduino dan Mikrokontroller 

b. Membangun dan Menganalisis Jaringan Komputer 
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BAGIAN I 

KONSEP PELAKSANAAN TUGAS AKHIR 

 

 

A. Jadwal Pelaksanaan Tugas Akhir 

Dalam pelaksanaannya, jadwal Tugas Akhir dibagi menjadi 2 tahapan. Adapun jadwal 

pelaksanaan Tugas Akhir adalah sebagai berikut : 

Jadwal Pelaksanaan Tugas Akhir  
 

Tanggal Keterangan 

Juli 2023 Sosialisasi Tugas Akhir 

Agsutus s.d Desember 2023 Pelaksanaan Peminatan 

Agsutus s.d Desember 2023 Pengajuan Tugas Akhir 

Oktober 2023 s.d Agustus 2024 Pelaksanaan Seminar dan Sidang 

 

 
B. Jadwal Pelaksanaan Peminatan 

Dalam pelaksanaannya, jadwal peminatan direncanakan sebagai berikut : 
 

Tanggal Kegiatan Peminatan 

07 s.d 25 Agustus 2023 Peminatan Judul (6 Sesi) 

04 s.d 29 September 2023 Peminatan Penulisan (4 Sesi) 

02 s.d 30 Oktober 2023 Peminatan Apsi (8 Sesi) 

06 Nopember s.d 22 Desember 2023 Peminatan Program (16 Sesi) 
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C. Jadwal Pelaksanaan Seminar dan Sidang 

Dalam pelaksanaannya, jadwal pelaksanaan seminar dan sidang Tugas Akhir dimulai 

Maret 2023 s.d September 2023, Adapun jadwal pelaksanaannya adalah sebagai berikut : 

Jadwal Pelaksanaan Seminar/Sidang Tugas Akhir Tahun 

2023/2024 

JADWAL 

PENDAFTARAN 

JADWAL 

PELAKSANAAN 

TAHAPAN – TAHAPAN 

SEMINAR 

PROPOSAL 

SEMINAR 

HASIL 

SIDANG MEJA 

HIJAU 

16 – 24 Oktober 
2023 

28 Oktober 2023 
Seminar Proposal 

Tahap 1 
  

26 -31 Oktober 
2023 

04 November 2023 
Seminar Proposal 

Tahap 2 
  

02 – 07 November 
2023 

11 November 2023 
Seminar Proposal 

Tahap 3 
Seminar Hasil 

Tahap 1 
 

09 – 14 November 
2023 

18 November 2023 
Seminar Proposal 

Tahap 4 
Seminar Hasil 

Tahap 2 
 

16 – 21 November 
2023 

25 November 2023 
Seminar Proposal 

Tahap 5 
Seminar Hasil 

Tahap 3 
Sidang Skripsi/Ta 

Tahap 1 

23 – 28 November 
2023 

2 Desember 2023 
Seminar Proposal 

Tahap 6 
Seminar Hasil 

Tahap 4 
Sidang Skripsi/Ta 

Tahap 2 

30 November –  
05 Desember 2023 

9 Desember 2023 
Seminar Proposal 

Tahap 7 
Seminar Hasil 

Tahap 5 
Sidang Skripsi/Ta 

Tahap 3 

07 – 12 Desember 
2023 

16 Desember 2023 
Seminar Proposal 

Tahap 8 
Seminar Hasil 

Tahap 6 
Sidang Skripsi/Ta 

Tahap 4 

14 – 19 Desember 
2023 

23 Desember 2023 
Seminar Proposal 

Tahap 9 
Seminar Hasil 

Tahap 7 
Sidang Skripsi/Ta 

Tahap 5 

21 – 26 Desember 
2023 

30 Desember 2023 
Seminar Proposal 

Tahap 10 
Seminar Hasil 

Tahap 8 
Sidang Skripsi/Ta 

Tahap 6 

28 Desember 2023 
– 02 Januari 2024 

6 Januari 2024 
Seminar Proposal 

Tahap 11 
Seminar Hasil 

Tahap 9 
Sidang Skripsi/Ta 

Tahap 7 

04 – 09 Januari 
2024 

13 Januari 2024 
Seminar Proposal 

Tahap 12 
Seminar Hasil 

Tahap 10 
Sidang Skripsi/Ta 

Tahap 8 

11 – 16 Januari 
2024 

20 Januari 2024 
Seminar Proposal 

Tahap 13 
Seminar Hasil 

Tahap 11 
Sidang Skripsi/Ta 

Tahap 9 

18 – 23 Januari 
2024 

27 Januari 2024 
Seminar Proposal 

Tahap 14 
Seminar Hasil 

Tahap 12 
Sidang Skripsi/Ta 

Tahap 10 

25 – 30 Januari 
2024 

3 Februari 2024 
Seminar Proposal 

Tahap 15 
Seminar Hasil 

Tahap 13 
Sidang Skripsi/Ta 

Tahap 11 

01 – 06 Februari 
2024 

10 Februari 2024 
Seminar Proposal 

Tahap 16 
Seminar Hasil 

Tahap 14 
Sidang Skripsi/Ta 

Tahap 12 

08 – 13 Februari 
2024 

17 Februari 2024 
Seminar Proposal 

Tahap 17 
Seminar Hasil 

Tahap 15 
Sidang Skripsi/Ta 

Tahap 13 

15 – 20 Februari 
2024 

24 Februari 2024 
Seminar Proposal 

Tahap 18 
Seminar Hasil 

Tahap 16 
Sidang Skripsi/Ta 

Tahap 14 

22 – 27 Februari 
2024 

02 Maret 2024 
Seminar Proposal 

Tahap 19 
Seminar Hasil 

Tahap 17 
Sidang Skripsi/Ta 

Tahap 15 

29 Februari – 05 
Maret 2024 

09 Maret 2024 
Seminar Proposal 

Tahap 20 
Seminar Hasil 

Tahap 18 
Sidang Skripsi/Ta 

Tahap 16 

07 – 12 Maret 2024 16 Maret 2024 
Seminar Proposal 

Tahap 21 
Seminar Hasil 

Tahap 19 
Sidang Skripsi/Ta 

Tahap 17 

14 – 19 Maret 2024 23 Maret 2024 
Seminar Proposal 

Tahap 22 
Seminar Hasil 

Tahap 20 
Sidang Skripsi/Ta 

Tahap 18 

21 -26 Maret 2024 30 Maret 2024 
Seminar Proposal 

Tahap 23 
Seminar Hasil 

Tahap 21 
Sidang Skripsi/Ta 

Tahap 19 



11  

 

JADWAL 

PENDAFTARAN 

JADWAL 

PELAKSANAAN 

TAHAPAN – TAHAPAN 
SEMINAR 

PROPOSAL 

SEMINAR 

HASIL 

SIDANG MEJA 

HIJAU 

28 Maret – 02 April 
2024 

06 April 2024 
Seminar Proposal 

Tahap 24 
Seminar Hasil 

Tahap 22 
Sidang Skripsi/Ta 

Tahap 20 

04 – 09 April 2024 13 April 2022 
Seminar Proposal 

Tahap 25 
Seminar Hasil 

Tahap 23 
Sidang Skripsi/Ta 

Tahap 21 

11 – 16 April 2024 20 April 2024 
Seminar Proposal 

Tahap 26 
Seminar Hasil 

Tahap 24 
Sidang Skripsi/Ta 

Tahap 22 

18 – 23 April 2024 27 April 2024 
Seminar Proposal 

Tahap 27 
Seminar Hasil 

Tahap 25 
Sidang Skripsi/Ta 

Tahap 23 

25 – 30 April 2024 04 Mei 2024 
Seminar Proposal 

Tahap 28 
Seminar Hasil 

Tahap 26 
Sidang Skripsi/Ta 

Tahap 24 

02 – 07 Mei 2024 11 Mei 2024 
Seminar Proposal 

Tahap 29 
Seminar Hasil 

Tahap 27 
Sidang Skripsi/Ta 

Tahap 25 

09 – 14 Mei 2024 18 Mei 2024 
Seminar Proposal 

Tahap 30 

Seminar Hasil 
Tahap 28 

Sidang Skripsi/Ta 
Tahap 26 

16 – 21 Mei 2024 25 Mei 2024 
Seminar Proposal 

Tahap 31 

Seminar Hasil 
Tahap 29 

Sidang Skripsi/Ta 
Tahap 27 

23 – 28 Mei 2024 01 Juni 2024 
Seminar Proposal 

Tahap 32 

Seminar Hasil 

Tahap 30 

Sidang Skripsi/Ta 
Tahap 28 

30 Mei – 04 Juni 
2024 

08 Juni 2024 
Seminar Proposal 

Tahap 33 

Seminar Hasil 

Tahap 31 

Sidang Skripsi/Ta 
Tahap 29 

06 – 11 Juni 2024 15 Juni 2024 
Seminar Proposal 

Tahap 34 

Seminar Hasil 

Tahap 32 

Sidang Skripsi/Ta 
Tahap 30 

13 – 18 Juni 2024 22 Juni 2024 
Seminar Proposal 

Tahap 35 

Seminar Hasil 

Tahap 33 

Sidang Skripsi/Ta 
Tahap 31 

20 – 25 Juni 2024 29 Juni 2024 
Seminar Proposal 

Tahap 36 

Seminar Hasil 

Tahap 34 

Sidang Skripsi/Ta 
Tahap 32 

27 Juni – 02 Juli 
2024 

06 Juli 2024 
Seminar Proposal 

Tahap 37 

Seminar Hasil 

Tahap 35 

Sidang Skripsi/Ta 
Tahap 33 

04 – 09 Juli 2024 13 Juli 2024 
Seminar Proposal 

Tahap 38 (denda) 

Seminar Hasil 

Tahap 36 

Sidang Skripsi/Ta 
Tahap 34 

11 – 16 Juli 2024 20 Juli 2024 
Seminar Proposal 

Tahap 39 (denda) 

Seminar Hasil 

Tahap 37 

Sidang Skripsi/Ta 
Tahap 35 

18 – 23 Juli 2024 27 Juli 2024 
Seminar Proposal 

Tahap 40 (denda) 

Seminar Hasil 

Tahap 38 (denda) 

Sidang Skripsi/Ta 
Tahap 36 

25 – 30 Juli 2024 03 Agustus 2024  
Seminar Hasil 

Tahap 39 (denda) 

Sidang Skripsi/Ta 
Tahap 37 

01 – 06 Agustus 
2024 

10 Agustus 2024  
Seminar Hasil 

Tahap 40 (denda) 

Sidang Skripsi/Ta 
Tahap 38 (denda) 

08 – 13 Agustus 
2024 

17 Agustus 2024   
Sidang Skripsi/Ta 
Tahap 39 (denda) 

15 – 20 Agustus 
2024 

24 Agustus 2024   
Sidang Skripsi/Ta 
Tahap 40 (denda) 

 

 

Nb. Jadwal dapat berubah sewaktu-waktu 
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D. Pengajuan Judul 

Berikut merupakan ketentuan pengajuan judul Tugas Akhir : 

1. Telah menyelesaikan dan lulus untuk seluruh mata kuliah minimal 5 semester. 

2. Tidak terdapat nilai gagal ( D atau E) dan Minimal IPK > 3,10 

3. Mengikuti Peminatan Judul 

Selain itu terdapat persyaratan dalam pengajuan judul tugas akhir, diantaranya : 

1. Surat Permohonan Tugas Akhir (Lampiran 1) 

2. Ringkasan Judul Tugas Akhir (Lampiran 2) 

3. Daftar Nilai Sementara (Validasi Biro Pengolahan Nilai) 

4. Fotocopy Bukti Pembayaran Uang Kuliah Cicilan Berjalan 

5. Validasi SKPI Sementara 

Judul yang diterima dan ditolak akan diumumkan melalui website : 

www.trigunadharma.ac.id, setiap minggunya pada hari sabtu. 

 
E. Seminar Proposal 

Berikut merupakan ketentuan pengajuan seminar proposal : 

1. Telah menyelesaikan dan lulus untuk seluruh mata kuliah semester 1 s.d 5. 

2. Melaksanakan Semester Pendek atau Ujian Pembersihan bagi mahasiswa yang 

IPK belum mencukupi 

3. Mengikuti peminatan sampai Peminatan APSI 

4. Menunjukkan 2 rangkap draft tugas akhir (Bab I s.d Bab III) pada saat mendaftar 

5. Draft tersebut diserahkan kepada Dosen Pembanding dengan menyertakan Berita 

Acara Serah Terima (Lampiran 12) 

Selain itu terdapat persyaratan dalam pengajuan Seminar Proposal, diantaranya : 

1. Melakukan pendaftaran seminar proposal secara online pada website: 

www.trigunadharma.ac.id 

2. Surat Permohonan Seminar Proposal (Lampiran 6) 

3. Fotocopy Bukti Pembayaran Uang Kuliah Cicilan Berjalan 

4. Fotocopy Bukti Pembayaran Uang Peminatan 

5. Fotocopy Bukti Pembayaran Uang Seminar Proposal 

6. Fotocopy Berita Acara Bimbingan (Accepted Bab I s.d III) 

7. Validasi SKPI Sementara 

8. Daftar Nilai Sementara (Validasi Biro Pengolahan Nilai) 

http://www.trigunadharma.ac.id/
http://www.trigunadharma.ac.id/
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F. Seminar Hasil 

Berikut merupakan ketentuan pengajuan seminar hasil : 

1. Telah menyelesaikan dan lulus seminar proposal (Lampiran 11). 

2. Mengikuti peminatan sampai Peminatan Program 

3. Menunjukkan 3 rangkap draft tugas akhir (semua BAB) pada saat mendaftar 

4. Draft tersebut diserahkan kepada Dosen Pembanding dengan menyertakan Berita 

Acara Serah Terima (Lampiran 12) 

Selain itu terdapat persyaratan dalam pengajuan Seminar Hasil, diantaranya : 

1. Melakukan pendaftaran seminar hasil secara online pada website: 

www.trigunadharma.ac.id 

2. Surat Permohonan Seminar Hasil (Lampiran 7) 

3. Fotocopy Bukti Pembayaran Uang Kuliah Cicilan Berjalan 

4. Fotocopy Bukti Pembayaran Uang Seminar Hasil 

5. Fotocopy Berita Acara Bimbingan (Accepted Semua BAB Tugas Akhir) 

6. Pas Photo Hitam Putih 3x4 sebanyak 4 Lembar 

7. Fotocopy Form Revisi Seminar Proposal 

8. Bukti Cek Plagiat Tugas Akhir (Validasi Perpustakaan) 

9. Daftar Nilai Sementara (Validasi Biro Pengolahan Nilai) 

10. Bukti Serah Terima Sumbangan Buku (Validasi Perpustakaan) 

 
G. Sidang (Ujian Komprehensif) 

Berikut merupakan ketentuan pengajuan sidang (ujian komprehensif) : 

1. Telah menyelesaikan dan lulus seminar hasil. 

2. Menunjukkan 3 rangkap draft tugas akhir jilid lux pada saat mendaftar 

Selain itu terdapat persyaratan dalam pengajuan sidang (ujian komprehensif), 

diantaranya : 

1. Melakukan pendaftaran sidang secara online pada website: 

www.trigunadharma.ac.id 

2. Surat Permohonan Sidang (Lampiran 9) 

3. Surat Keterangan Bebas Administrasi (Validasi Bagian Keuangan) 

4. Fotocopy Berita Acara Bimbingan (Accepted Ketua Program Studi) 

5. Fotocopy Form Revisi Seminar Hasil 

6. Surat Keterangan telah diterima Draft HKI (Hak Kekayaan Intelektual) 

7. Validasi SKPI Sementara 

http://www.trigunadharma.ac.id/
http://www.trigunadharma.ac.id/
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8. File (Ijazah SMA, KTP, Pas photo berwarna, Tugas Akhir dan Program) 

9. Daftar Nilai Sementara (Validasi Biro Pengolahan Nilai) 

 
H. Tata Cara Pelaksanaan Seminar/Sidang 

Berikut merupakan tata cara pelaksanaan seminar/sidang : 

1. Seluruh peserta hadir pada pukul : 08.00 Wib sesuai dengan jadwal pelaksanaan 

yang ditetapkan akademik ( Jadwal pelaksanaan dapat dilihat melalui website : 

www.trigunadharma.ac.id ). 

2. Wajib mengenakan pakaian (Pria : Jas hitam, kemeja putih, celana keper hitam 

memakai dasi dan sepatu hitam resmi bukan sepatu sport, untuk wanita harus 

mengenakan jas hitam, kemeja putih, jilbab putih (bagi yang mengenakan jilbab), 

rok panjang (sampai mata kaki) berwarna hitam dan sepatu hitam resmi. 

3. Membawa draft tugas akhir pada saat pelaksanaan dan menyiapkan presentasi 

tugas akhir. 

4. Penutupan pelaksanaan seminar/sidang setiap pekannya akan diumumkan 

kelulusan serta yudisium dari masing-masing mahasiswa. 

 

I. Perbaikan Seminar/Sidang (Ulang) 

Seminar/sidang ulang terjadi karena mahasiswa dianggap gagal oleh Dosen 

Pembanding/Penguji (Nilai D dan E). Berikut merupakan ketentuan dari 

seminar/sidang ulang: 

1. Telah memperbaiki segala kesalahan yang terdapat dalam Tugas Akhir 

2. Melakukan pendaftaran seminar/sidang ulang. 

Selain itu terdapat persyaratan dalam seminar/sidang ulang, diantaranya : 

1. Surat Permohonan Seminar/Sidang Ulang(Lampiran 14). 

2. Fotocopy Bukti Pembayaran Uang Seminar/Sidang Ulang. 

 
J. Wisuda 

Berikut merupakan persyaratan dalam pendaftaran wisuda : 

1. Bukti Tanda Terima Tugas Akhir (Lampiran 13) 

2. Bukti Pembayaran Uang Wisuda 

3. Surat Pengambilan Ijazah (Validasi Bag. Keungan) 

Selain itu terdapat ketentuan dalam pelaksanaan wisuda, diantaranya : 

1. Pengambilan toga dan undangan wisuda akan diumumkan sesuai jadwal. 

http://www.trigunadharma.ac.id/
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2. Mengikuti pelaksanaan gladi resik dan wisuda sesuai dengan jadwal yang 

ditentukan. 

 

K. Bukti Tanda Terima Tugas Akhir 

Berikut merupakan ketentuan dari penyerahan tugas akhir : 

1. Untuk Pembimbing berupa file draft tugas akhir dan program. 

2. Untuk Perpustakaan berupa draft tugas akhir, program, scan lembar pengesahan 

lembar persetujuan, berita acara bimbingan yang telah ditanda tangani dan 

distempel. 
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L. Komponen SKPI 

 

Komponen SKPI menjadi salah satu syarat dalam Pengajuan Judul Tugas Akhir, 

Seminar Proposal dan Sidang dengan ketentuan sebagai berikut : 

 

KOMPONEN SKPI SYARAT 

Prestasi dan Penghargaan Optional 

Kompetensi Keahlian Syarat Seminar Proposal 

Penelitian, Pengabdiaan Masyarakat 

dan Karya Ilmiah 
Syarat Sidang 

Kerja Praktik/ Magang/ Program 

Kreativitas 
Syarat Pengajuan Tugas Akhir 

Kegiatan Kemahasiswaan Syarat Kerja Praktik 

 

Berikut ini merupakan ketentuan kegiatan dari komponen SKPI yang diakui oleh 

institusi : 

Komponen SKPI Ketentuan Kegiatan 

 

 

 

Prestasi dan Penghargaan 

1. Prestasi akademik dan non akademik 

2. Dokumen prestasi menampilkan keterangan juara, piala 

atau medali yang diterima 

3. Level terendah yang diterima adalah wilayah 
kota/kabupaten. 

4. Penghargaan sebagai pembicara, tentor/instruktur atau 

kegiatan-kegiatan kelembagaan atau seminar dan 

sejenisnya minimum pada tingkat kabupaten/kota 
5. Kepanitiaan dalam acara kelembagaan atau nasional 

 

 

 

Kompetensi Keahlian 

1. Sertifikat Bahasa (diakui skala Nasional) seperti TOEFL, 
IELTS, TOEIC, dan lain sebagainya. 

2. Sertifikat Komputer (kompetensi, keahlian, completion, 
atau achievement) 

3. Sertifikasi yang dikeluarkan oleh lembaga sertifikasi atau 

kompetensi seperti : Progate, Dicoding, Cisco, Red hat, 

Mirkotik, DQ Lab, LSP/BSNP, Atau Vendor/Lembaga 

yang diakui sertifikasinya skala Nasional atau 
Internasional lainnya. 
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Komponen SKPI Ketentuan Kegiatan 

 
 

Penelitian, Pengabdiaan 

Masyarakat dan Karya Ilmiah 

1. Publikasi Karya Ilmiah seperti : Jurnal Nasional, Hak 
Kekayaan Intelektual, Teknologi Tepat Guna dan Buku 

2. Jurnal dari Tugas Akhir anda juga termasuk dalam 

publikasi Karya ilmiah 
2.   Kegiatan riset dan pengabdian masyarakat dengan 

berkolaborasi dengan dosen. 

Kerja Praktik/ Magang/ 
Program Kreativitas 

1. Kegiatan Kerja Praktik /Magang 
2. Kegiatan Program Kreativitas Mahasiswa 

Kegiatan Kemahasiswaan 
Kegiatan seminar nasional atau pelatihan (sebagai 
peserta/panitia) minimal 2 kegiatan 

 

Berikut ini merupakan contoh SKPI Sementara yang dapat dicetak setelah divalidasi 

oleh Waka III Bidang Kemahasiswaan. Proses tunggu validasi paling lama 1 hari. 
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3 

4 3 

3 

4 

4 3 

3 

 

 

 

 

Judul Bab 

 
 
 
 
 
 
 
 

Bukan Judul 

Bab 

BAGIAN II 

TEKNIK PENULISAN 

 
A. Pengaturan Kertas 

Berikut ketentuan pengaturan kertas dalam penyusunan Tugas Akhir : 

1. Ukuran Kertas : A4 / 70 gram 

2. Margin : 
 

a. Judul Bab :  

- Batas Atas (Top) : 4 cm 

- Batas Kiri (Left) : 4 cm 

- Batas Kanan (Right) : 3 cm 

- Batas Bawah (Bottom) : 3 cm 

b. Bukan Judul Bab :   

- Batas Atas (Top) : 3 cm 

- Batas Kiri (Left) : 4 cm 

- Batas Kanan (Right) : 3 cm 

- Batas Bawah (Bottom) : 3 cm 
 

Gambar 1. Pengaturan Kertas 
 

3. Untuk kalimat awal pada setiap paragraf baru di tab 1,25 cm dari tepi kiri. 

4. Setiap bab dibatasi dengan kertas pembatas bab berwarna Hijau untuk Program 

Studi Manajemen Informatika dan Biru untuk Teknik Komputer 
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Contoh :  
 

1,25 cm (1 tab) 

 

1.1 Sub Judul 1 
 

Jarak 2 Spasi Baris 

..................................................................................................................... 

..................................................................................................................J.a.r.a..k..2..S..p.a..s.i 

.......................................................................................................................
B
.
a
..
r
.
is
...... 

 

1.2 Sub Judul 1 Jarak 3 Spasi Baris 

..................................................................................................................... 

................................................................................................................................. 
 

1.2.1 Sub Judul 2 Jarak 2 Spasi Baris 

..................................................................................................................... 

................................................................................................................................. 
 

1.2.1.1 Sub Judul 3 
Jarak 2 Spasi Baris 

..................................................................................................................... 

................................................................................................................................. 
 

1. Sub Judul 4 Jarak 2 Spasi Baris 

..................................................................................................................... 

..................................................................................................................... 

2. Sub Judul 4 

..................................................................................................................... 

a. Sub Judul 5 

.............................................................................................................. 

.............................................................................................................. 

b. Sub Judul 5 

.............................................................................................................. 

- Sub Judul 6 

.......................................................................................................... 

- Sub Judul 6 

.......................................................................................................... 

 
Gambar 2. Struktur Penomoran 

Contoh : Membuat list atau daftar 
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Gambar 3. Struktur Daftar 

 
 

B. Pengetikan 

Berikut ketentuan pengaturan kertas dalam penyusunan Tugas Akhir : 

1. Judul Bab diketik dengan ketentuan : 
a. Jenis huruf : Times New Roman 

b. Efek cetak : Bold 

c. Ukuran huruf : 14 

d. Jarak kalimat baru judul : 2 Spasi 

e. Jarak ke baris berikutnya : 4 Spasi 

f. Diketik dengan huruf kapital 

 

2. Sub Judul 1 diketik dengan ketentuan : 
a. Jenis huruf : Times New Roman 

b. Efek cetak : Bold 

c. Ukuran huruf : 12 

d. Jarak ke baris berikutnya : 2 Spasi 

e. Jarak ke baris sebelumnya : 3 Spasi 

f. Diketik dengan awal kata huruf besar dan teks berikutnya kecil (Capitalize Each 

Word) 

 

3. Sub Judul 2, 3, dan 4 diketik dengan ketentuan : 

a. Jenis huruf : Times New Roman 

b. Efek cetak : Bold 

c. Ukuran huruf : 12 

d. Jarak ke baris berikutnya : 2 Spasi 

e. Jarak ke baris sebelumnya : 2 Spasi 

f. Diketik dengan awal kata huruf besar dan teks berikutnya kecil (Capitalize Each 
Word) 

BAB I 

PENDAHULUAN 

Jarak 4 Spasi Baris 

1.1 Sub Judul 1 

..................................................................................................................... 

.............................................0.,.7..5..c.m...(.1..t.a.b..)................................................................... 

................................................................................................................................. 

1. ............................................................................................................................ 

........................................................................J..a.r.a.k..2...S.p..a.s..i .B..a.r.i.s.............................. 

2. ............................................................................................................................ 

............................................................................................................................ 
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4. Kata Pengantar diketik dengan ketentuan : 

a. Jenis huruf : Times New Roman 
b. Ukuran huruf : 12 

c. Jarak antar baris : 2 Spasi 

d. Jarak baris judul ke baris paragraf awal : 4 Spasi 

e. Judul diketik dengan huruf kapital 

 
5. Daftar Isi, Daftar Tabel, Daftar Gambar dan Daftar Lampiran : 

a. Jenis huruf : Times New Roman 

b. Ukuran huruf : 12 

c. Jarak antar baris : 2 Spasi 

d. Jarak baris judul ke baris paragraf awal : 4 Spasi 

e. Judul diketik dengan huruf kapital 

 

6. Abstrak diketik dengan ketentuan : 
a. Jenis huruf : Times New Roman 

b. Ukuran huruf : 12 

c. Jarak antar baris : 1 Spasi 

d. Jarak baris judul ke baris paragraf awal : 4 Spasi 

e. Judul diketik dengan huruf kapital. 

f. Isi abstrak bercetak miring 

 

7. Daftar Pustaka diketik dengan ketentuan : 
a. Jenis huruf : Times New Roman 

b. Ukuran huruf : 12 

c. Jarak antar baris : 1 Spasi 

d. Jarak baris judul ke baris paragraf awal : 4 Spasi 

e. Judul diketik dengan huruf kapital 

f. Daftar pustaka wajib menggunakan Insert Bibliography pada software 

pendukung sitasi (Mendeley) 

 

8. Listing Program diketik dengan ketentuan : 
a. Jenis huruf : Courier New 

b. Ukuran huruf : 10 

c. Jarak antar baris : 1 Spasi 

d. Jarak baris judul ke baris paragraf awal : 4 Spasi 

e. Judul diketik dengan huruf kapital 

 

9. Jumlah halaman mulai Bab I s.d Bab V : Minimal 50 Halaman 

10. Jarak antar baris dalam penulisan Tugas Akhir secara umum : 2 Spasi. 

11. Pada isian yang memerlukan list/daftar maka dimulai penomoran 1,2,3 dan 

seterusnya. Jarak yang digunakan antara nomor dengan teks : 0,75 cm. 
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C. Penomoran Halaman 

Berikut ketentuan penomoran halaman dalam penyusunan Tugas Akhir : 

1. Kata pengantar, daftar isi, daftar gambar, daftar tabel dan daftar lampiran dimulai 

dengan nomor halaman i, ii, iii, dan seterusnya. 

2. Halaman pertama dimulai dari Bab I (Pendahuluan) 

3. Pada setiap awal Bab, penomoran halaman terletak di tengah bawah. 

4. Kelanjutan Bab pada halaman berikutnya, penomoran halaman terletak di kanan 

atas. 

5. Untuk Lampiran dimulai dengan nomor halaman L-1, L-2 dan seterusnya. 

 
 

D. Penomoran Judul 

Berikut ketentuan penomoran judul dalam penyusunan Tugas Akhir : 

1. Urutan Sub Judul 1 dimulai dengan penomoran 1.1, 1.2, untuk Bab I atau 2.1, 2.2 

untuk Bab II dan seterusnya. 

2. Urutan Sub Judul 2 dimulai dengan penomoran 1.1.1, 1.1.2 atau 2.1.1, 2.1.2 dan 

seterusnya. 

3. Urutan Sub Judul 3 dimulai dengan penomoran 1.1.1.1, 1.1.1.2 atau 2.1.1.1, 2.1.1.2 

dan seterusnya. 

4. Urutan Sub Judul 4 dimulai dengan penomoran 1, 2, 3 dan seterusnya. 

5. Urutan Sub Judul 5 dimulai dengan penomoran a, b, c dan seterusnya 

6. Urutan Sub Judul 6 dimulai dengan penomoran tanda penghubung (-) 

7. Jarak antara nomor sub judul dengan teks sub judul adalah 1,25 cm (1 tab) 

 
E. Tata Bahasa 

Berikut ketentuan tata bahasa dalam penyusunan Tugas Akhir : 

1. Tugas Akhir ditulis dengan menggunakan bahasa Indonesia baku, sesuai dengan 

ejaan bahasa Indonesia yang disempurnakan. 

2. Sedapat mungkin menggunakan istilah yang telah diadaptasi ke bahasa Indonesia, 

jika menggunakan istilah asing harus diberikan tanda khusus berupa tulisan yang 

dicetak miring 

3. Kalimat dalam Tugas Akhir tidak boleh menggunakan kata penulis, kata ganti 

orang, misalnya saya, kami dan sebagainya, kecuali pada Kata Pengantar. 
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4. Gelar kesarjanaan dan gelar lainnya tidak boleh dicantumkan dalam penulisan 

nama, kecuali dalam ucapan terima kasih kepada pembimbing, penguji serta 

pengesahan oleh pejabat berwenang pada Kata Pengantar. 

5. Setiap nama tempat riset dan aplikasi diketik dengan awal kata huruf besar dan teks 

berikutnya kecil (Capitalize Each Word). 

 

F. Daftar Pustaka 

Berikut ketentuan daftar pustaka dalam penyusunan Tugas Akhir : 

1. Dalam penyusunan Tugas Akhir, mahasiswa wajib menyertakan/memiliki sumber 

referensi (literatur) minimal 12 referensi (5 Tahun Terakhir) meliputi Jurnal 

Nasional, Proseding, Buku, dan Website imiah (Google Scholar) atau dari 

lembaga/instansi resmi. 

2. Daftar pustaka wajib menggunakan Insert Bibliography pada software pendukung 

sitasi (Mendeley). 

3. Penulisan daftar pustaka untuk tulisan(artikel) yang ada pada Jurnal dengan 

menggunakan format penulisan : 

[Nomor Sitasi] Inisial Nama Depan. Nama Belakang, “Judul Artikel”, Nama 

Jurnal, Vol. Volume, No. Nomor, pp. Halaman, Tahun Terbit. 

Contoh Penulis Tunggal : 

[1] Astri Syahputri, “Aplikasi Pembelajaran Bahasa Arab Berbasis Android”, 

Saintikom, vol.7, no.3, pp. 1-10, 2021. 

Contoh Dua Penulis: 

[2] P.S. Ramadhan, “Sistem Informasi Pembelajaran Berbasis Flash”, Cyber 

Tech, vol.6, no.4, pp. 16-20, 2020. 

Contoh Tiga Penulis atau Lebih: 

[3] E.Sasana, S.Ghilang, and A.S. Putri, “Sistem Informasi Pembelajaran 

Berbasis Flash Android”, J-Sisko Tech, vol.1, no.3, pp. 21-26, 2019. 

4. Penulisan daftar pustaka untuk tulisan yang ada pada Buku dengan menggunakan 

format penulisan : 
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[Nomor Sitasi] Inisial Nama Depan. Nama Belakang, Judul Buku, edisi. Kota 

Penerbit : Nama Penerbit, Tahun Terbit. 

Contoh Penulis Tunggal : 

[1] J. Pradana, Pengenalan Metode Pembelajaran, 1st ed. Medan: Penerbit RP 

Press, 2021. 

Contoh Dua Penulis: 

[2] S. Amirah and E. Suryani, Jago Android Aplikasi, 1st ed. Bandung: 

Penerbit Mulgia, 2020. 

Contoh Tiga Penulis atau Lebih : 

[3] T.Sugiono, S.Diansyah, and E. Fatdhilah, Penerapan Flash untuk 

Pemrograman Mobile, 2nd ed. Yogyakarta: Penerbit Surya, 2019. 

 

5. Penulisan daftar pustaka untuk tulisan yang ada pada Web Page dengan 

menggunakan format penulisan : 

[Nomor Sitasi] Inisial Nama Depan. Nama Belakang, Judul Tulisan, Laman, 

Tahun Terbit. [url]. 

Contoh Penulis Tunggal : 

[1] B. Syahputra, “Sejarah Huruf Kanji”, Wikipedia, 2018. 

www.wikipedia/sejarah-huruf-kanji/ii.com. 

 

G. Tabel 

Berikut ketentuan tabel dalam penyusunan Tugas Akhir : 

1. Penomoran tabel menggunakan kombinasi angka yang dipisahkan oleh titik. 

Angka pada bagian depan menunjukkan bab dan angka pada bagian belakang 

menunjukkan nomor urut tabel dalam bab tersebut. 

Contoh      :   Tabel 2.1 Simbol-Simbol Flowchart 

Artinya : Tabel tersebut berada pada Bab 2 dan urutan pertama pada bab 

tersebut. 

2. Judul tabel ditempatkan di atas tabel dengan perataan tengah. 
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Kepala Tabel 

Harus bercetak 

Tebal (Bold) 

Contoh : 

Adapun simbol-simbol yang digunakan adalah [2] : 

Tabel 2.1 Simbol-Simbol Flowchart 
 

No Simbol Arti Kegunaan 

1  

 

 

Kegiatan 

Manual 

 

Menunjukkan pekerjaan manual. 

2 
 

 

 
Proses 

Menunjukkan kegiatan atau 

proses dan operasi program 

komputer. 

 
3. Tabel tidak boleh dipenggal kecuali sangat terpaksa, misalnya karena tidak cukup 

pada satu halaman penuh. Jika terjadi pemenggalan tabel maka pada halaman 

selanjutnya harus diberi kepala tabel dan tetap menempatkan judul tabel diatas 

tabel dengan tambahan kata (Lanjutan). 

Contoh : 
 

Hal. Pertama 

Tabel 2.1 Simbol-Simbol Flowchart 

 
No Simbol Arti Kegunaan 

1  

 

 

Kegiatan 

Manual 

 

Menunjukkan pekerjaan manual. 

2 
 

 

 
Proses 

Menunjukkan kegiatan atau 

proses dan operasi program 

komputer. 
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Hal. Kedua 

Tabel 2.1 Simbol-Simbol Flowchart (Lanjutan) 

 
No Simbol Arti Kegunaan 

3  

 

 
Dokumen 

Menunjukkan dokumen input 

dan output baik untuk proses 

manual, mekanik dan komputer. 

4  

 

 
Keputusan 

Langkah pengambilan 

keputusan. 

 

 

G. Gambar 

Berikut ketentuan gambar dalam penyusunan Tugas Akhir : 

1. Penomoran gambar menggunakan kombinasi angka yang dipisahkan oleh titik. 

Angka pada bagian depan menunjukkan bab dan angka pada bagian belakang 

menunjukkan nomor urut gambar dalam bab tersebut. 

Contoh     :   Gambar 2.1 Microsoft Visual Studio 2008 

Artinya       :   Gambar tersebut berada pada Bab 2 dan urutan pertama pada 

bab tersebut. 

2. Judul gambar ditempatkan di bawah gambar dengan perataan tengah. 

Contoh : 

Berikut ini merupakan gambar visual studio 2008 [2] : 
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Gambar 2.1 Microsoft Visual Studio 2008 

 
H. Penjilidan 

Berikut ketentuan penjilidan dalam penyusunan Tugas Akhir : 

1. Warna kulit Tugas Akhir : Hijau Lumut (Prodi MI), Biru Muda (Prodi TK) 

2. Jilid LUX (Hard Cover) 

3. Tinta emas untuk sampul, lembar persetujuan dan lembar pengesahan. 

4. Lembar kosong berwarna Hijau Lumut (Prodi MI) dan Biru Muda (Prodi TK) 

pada lembar pertama setelah sampul. 

5. Sampul (cover) juga dicetak pada kertas HVS di halaman pertama setelah lembar 

kosong 

6. Setiap bab memiliki pemisah bab, lembar pemisah bab berwarna Hijau Lumut 

(Prodi MI) dan Biru (Untuk TK) 
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BAGIAN III 

SISTEMATIKA TUGAS AKHIR 

 
A. Susunan Tugas Akhir 

Dalam penyusunan Tugas Akhir terdapat 3 bagian, yaitu : 

1. Bagian Awal, terdiri dari : 

- Sampul (cover) Depan 

- Halaman Judul Tugas Akhir 

- Lembar Persetujuan 

- Lembar Pengesahan 

- Surat Pernyataan 

- Kata Pengantar 

- Abstrak 

- Daftar Isi 

- Daftar Gambar 

- Daftar Tabel 

- Daftar Lampiran 

2. Bagian Isi, terdiri dari : 

(Program Studi Manajemen Informatika) 

- Bab I Pendahuluan 

- Bab II Landasan Teori 

- Bab III Metodologi Penelitian 

- Bab IV Hasil dan Pembahasan 

- Bab V Kesimpulan dan Saran 

(Program Studi Teknik Komputer) 

- Bab I Pendahuluan 

- Bab II Landasan Teori 

- Bab III Analisa dan Perancangan Sistem 

- Bab IV Hasil dan Pengujian 

- Bab V Kesimpulan dan Saran 
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3. Bagian Akhir, terdiri dari : 

- Daftar Pustaka 

- Lampiran Listing Program 

- Lampiran Data Pendukung Lainnya 

- Berita Acara Bimbingan Tugas Akhir 

- Surat Keputusan Penghunjukan Dosen Pembimbing 

- Daftar Riwayat Hidup 

B. Penjelasan Isi Tugas Akhir 

Berikut merupakan penjelasan dari Isi Tugas Akhir : 
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Ukuran Logo 

5 cm x 5 cm 

Contoh Cover Depan Prodi Manajemen Informatika 

 
 

APLIKASI ANIMASI PEMBALAJARAN PENGENALAN 
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BAB I 

PENDAHULUAN 

 

 

 

1.1 Latar Belakang 

 

Bagian ini menguraikan tentang alasan penelitian dilakukan dengan 

mengemukakan permasalahan yang diteliti serta cara menyelesaikan permasalahan yang 

dianalisa. Berikut ketentuan dari latar belakang : 

1. Berisi tentang topik yang akan dibahas dalam Tugas Akhir, meliputi : Objek dari 

penelitian (kasus yang diangkat), gagasan atau kebaruan yang ingin ditemukan dan 

solusi yang ditawarkan. 

2. Deskripsi latar belakang adalah 2 sampai dengan 3 halaman. 

 

3. Menyertakan referensi (kutipan) dari penelitian sebelumnya untuk memperkuat 

gagasan atau kebaruan penelitian yang dikemukakan. 

4. Penggunaan referensi (kutipan) pada latar belakang adalah 2 sampai dengan 5 

referensi. Pada kutipan tersebut secara umum menjelaskan tentang (objek penelitian 

dan permasalahan 

5. Diakhir paragraf pada latar belakang harus mencantumkan judul yang diangkat 

dengan diberi tanda “ ”, dan bold dengan huruf kapital. 

“APLIKASI ANIMASI PEMBALAJARAN PENGENALAN HURUF ALFABET, 

NAMA HEWAN DAN WARNA PADA ANAK USIA DINI” 

Bagian Isi Prodi Manajemen Informatika 
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1.2 Rumusan Masalah 

 

Bagian ini memaparkan tentang point-point yang merujuk pada latar belakang dari 

penelitian yang diangkat untuk dapat diselesaikan dalam bentuk daftar pertanyaan. Berikut 

ketentuan dari rumusan masalah : 

1. Rumusan masalah dimulai dengan kata tanya yang perlu dijawab secara rinci dan jelas 

pada hasil penelitian. Seperti : Bagaimana, Mengapa atau Apakah. 

2. Pertanyaan penelitian harus relevan dengan topik penelitian yang dikaji. 

 

3. Pastikan bahwa rumusan masalah yang ditetapkan memiliki nilai penelitian, yang 

nantinya akan dibahas pada Bab III, IV dan V. 

 

1.3 Batasan Masalah 

 

Bagian ini menjelaskan tentang batasan atau cakupan permasalahan yang akan 

diselesaikan agar tidak meluas ke area permasalahan lainnya sehingga fokus penelitian 

dapat dilakukan dengan optimal. Berikut ketentuan dari batasan masalah : 

1. Tidak boleh mencantumkan nama produk software. 

 

2. Mencantumkan variabel atau kriteria yang digunakan dalam penelitian. 

 

3. Menjelaskan tentang data yang digunakan dalam penelitian, seperti : sumber, periode 

dan bentuk data. 

4. Mengemukakan model atau basis aplikasi yang digunakan. Contoh : Berbasis Mobile, 

Dekstop, Web atau lainnya. 

 

1.4 Tujuan Penelitian 

 

Bagian ini berisi tentang tujuan yang akan hendak dicapai sesuai dengan rumusan 

masalah yang telah dibuat. Berikut ketentuan dari tujuan penelitian : 

1. Tujuan penelitian dimulai dengan kata “Untuk” yang bermakna sesuatu hasil yang 

akan diharapkan dari proses yang akan dilaksanakan. 
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2. Tujuan penelitian haruslah memiliki hubungan yang jelas dari masing-masing point 

pada rumusan masalah sehingga dapat diartikan tujuan merupakan solusi dari sebab 

akibat yang dituangkan pada rumusan masalah. 

 

 

1.5 Manfaat Penelitian 

 

Bagian ini berisi tentang dampak/pengaruh yang diperoleh dari penelitian yang 

dilakukan. Berikut ketentuan dari manfaat penelitian : 

1. Manfaat penelitian dimulai dengan kata “Dapat” yang bermakna manfaat dari hasil 

penelitian yang dilakukan. 

2. Manfaat penelitian minimal memiliki dampak/pengaruh terhadap ilmu pengetahuan 

dan sistem yang diterapkan. 
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BAB II 

LANDASAN TEORI 

 

 

2.1 Teori Tentang Kasus Yang Diangkat 

 

Berisi uraian singkat tentang bahan referensi yang digunakan sebagai metodologi 

dalam memecahkan permasalahan penelitian. 

Landasan teori berupa uraian-uraian teoritis yang hanya berkaitan dengan masalah yang 

diteliti. Landasan teori ini diperoleh dan dijabarkan dari acuan pustaka/studi pustaka 

yang digunakan dan disusun sendiri oleh mahasiswa untuk menyusun kerangka pengerjaan 

tugas akhir. 

Landasan teori berisi penjelasan tentang teori-teori yang digunakan dalam penulisan, 

meliputi : 

- Teori tentang bahan penelitian, temuan serta bahan penelitian yang diperoleh dari 

berbagai referensi. 

- Teori tentang aplikasi yang digunakan dalam proses penyelesaian kasus/sistem 

yang dirancang. 

- Rumus-rumus maupun tahapan-tahapan yang nantinya digunakan dalam proses 

penyelesaian kasus yang diangkat,. 

- Teori mengenai metode pengembangan sistem. 

 

- Teori tentang teknik dan cara analisa dan perancangan. 

 

- Teori mengenai diagram-diagram yang digunakan. 
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2.2 Gambaran Umum Perusahaan 

 

Penjelasan singkat tentang organisasi/perusahaan yang dianalisis, termasuk penjelasan 

tentang   struktur   organisasi   dan   job   description.   Pada    tinjauan organisasi 

dijelaskan juga tujuan organisasi/perusahaan sehingga memudahkan dalam menganalisis 

proses bisnis yang dilakukan. 

Sesuaikan sub bab dengan landasan teoritis yang anda gunakan 
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BAB III 

METODOLOGI PENELITIAN 

 
 

3.1 Metode Analisis Kebutuhan Sistem 

 

Berisi penjelasan tentang metode pengumpulan data yang digunakan. Secara 

umum metode yang digunakan dalam pengumpulan data untuk memecahkan masalah 

dalam penyelesaian kasus yang diangkat adalah sampling dan investigasi, Studi Literatur, 

wawancara, observasi, kuesioner dan/atau prototyping. 

 
3.1.1 Teknik Pengumpulan Data 

 

Teknik pengumpulan data merupakan faktor penting demi keberhasilan penelitian. 

Hal ini berkaitan dengan bagaimana cara mengumpulkan data, siapa sumbernya, dan apa 

alat yang digunakan. 

 
3.1.2 Analisis Sistem Berjalan 

 

Analisis sistem yang sedang berjalan adalah penguraian   terhadap   suatu 

sistem yang diamati dengan maksud untuk mengidentifikasi dan mengevaluasi 

permasalahan -permasalahan, kesempatan -kesempatan, hambatan-hambatan yang terjadi 

dan kebutuhan-kebutuhan yang diharapkan sehingga dapat di usulkan perbaikan- 

perbaikan. 

 
3.1.2.1 Analisis Masukan 

 

Analisis masukan   merupakan   penjelasan   dari   dokumen   masukan 

berdasarkan sistem yang berjalan setelah melakukan pengamatan di perusahaan. 
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3.1.2.2 Analisis Prosedur 
 

Analisis sistem berjalan digambarkan dengan flow of Document (diagram alir 

dokumen). FOD digambarkan berdasarkan prosedur dari perusahaan. 

 
3.1.2.3 Analisis Laporan 

 

Analisis laporan merupakan penjelasan dari dokumen laporan berdasarkan sistem 

yang berjalan setelah melakukan pengamatan di perusahaan. 

 
3.2 Metode Perancangan Sistem Yang Akan Dibangun 

 

Metode perancangan sistem berisi rancangan yang digunakan dalam membangun 

sistem, diantaranya rancangan proses, rancangan output, rancangan input, rancangan 

database, rancangan sistem dan rancangan interface. 

 
3.2.1 Rancangan Proses 

 

Berisi gambar rancangan proses yang dimodelkan dengan Data Flow 

Diagram (DFD). Penggambaran DFD harus dirinci. DFD harus dimulai dengan 

penggambaran konteks diagram, DFD level 0 dan DFD level selanjutnya. Semua proses 

dalam DFD yang dirancang diuraikan berdasarkan spesifikasi proses masing-masing. 

Spesifikasi proses dideskripsi dengan format berikut : 

Spesifikasi Proses : 

 
Nomor Proses : nomor proses yang sesuai dengan nomor pada DFD 

Nama : nama proses yang sesuai dengan nomor pada DFD 

Masukan : nama-nama data masukan proses yang tertera pada DFD 

Keluaran : nama-nama data keluaran proses yang tertera pada DFD 
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Uraian : menjelaskan berbagai macam uraian yang berkaitan dengan 

komputasi yang terjadi dalam proses 

Contoh : 

 

Spesifikasi Proses : 

 

Nama Proses : 3.1.1 

 

Nama Proses : Cetak Kwitansi 

 

Masukan : File Nota, File Kwitansi, File SMB, File Plg, File Isi 

Keluaran : Kwitansi, File Kwitansi 

Uraian : 

 

- Kwitansi merupakan bukti penagihan untuk pelunasan bayar yang berisi 

no_kwit, tgl_kwit, no_nota, nm_plg, dan jumlah. 

- No_kwit didapat dari no_kwit terakhir (pada file kwitansi) ditambah Satu. 

 

- Tgl_kwit didapat dari tanggal sistem saat pencetakan kwitansi. 

 

- No_nota dientry oleh user sedangkan DP diambil dari file nota. 

 

- Pada akhir kwitansi dilakukan perhitungan total yang diproses dengan cara 

mentotal seluruh jumlah, sedangkan jumlah diproses dengan mengkalikan hrg_jual 

dengan qty (hrg_jual dan qty berasal dari file isi). 

- Pada akhir kwitansi juga dilakukan perhitungan sisa yang diproses dengan 

cara: 

Jika DP>=Total maka sisa = DP – total 

Jika DP<total maka sisa = total – DP 

- Pada akhir kwitansi dicetak jumlah yang diisi dengan variabel sisa, no_kwit, 

tgl_kwit, dan no_nota disimpan ke file kwitansi sebelum dicetak. 
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3.2.2 Rancangan Keluaran 
 

Berisi gambaran tentang rancangan output/keluaran   yang akan dihasilkan 

oleh sistem yang dirancang. Setiap rancangan keluaran harus disertai gambar rancangan 

dan harus dijelaskan. 

 
3.2.3 Rancangan Masukan 

 

Berisi gambaran tentang rancangan input/masukan yang dibutuhkan oleh sistem 

yang dirancang. Setiap rancangan masukan harus disertai gambar rancangan dan 

harus dijelaskan. 

 
3.2.4 Rancangan Basis Data 

 

Berisi pemodelan data yang dituangkan dalam bentuk ERD, Normalisasi dan 

rancangan tabel. 

 
3.2.4.1 Entity Relational Diagram 

 

Menunjukkan hubungan entity pada data flow diagram. 

 

 

3.2.4.3 Rancangan Tabel 

 

Pada bagian ini juga menjelaskan spesifikasi basis data yang akan dirancang 

sesuai dengan kebutuhan sistem yang akan dikembangkan. Spesifikasi basis data harus 

dirinci dan disesuaikan dengan software yang akan dipakai pada saat implementasi 

dilakukan. 



 

 

Format rincian dari spesifikasi basis data adalah sebagai berikut : 

Nama Tabel : Berisikan nama tabel 

Kegunaan : Berisikan kegunaan tabel terhadap sistem yang 

dibangun. Uraian : Menjelaskan tabel lebih rinci. 

 
Tabel 3.1 Contoh Struktur Desain Tabel 

 

No. Nama Field Jenis Lebar Keterangan 

  Numeric   

  Character   

  Date   

  Logical   

  Dll   

 
 

3.2.5 Rancangan Program 
 

Berisi gambar rancangan program yang dimodelkan dengan flowchart. 

Penggambaran flowchart harus dirinci dan berdasarkan pada program yang 

dirancang. 

 
3.2.6 Rancangan Interface 

 

Berisi gambaran struktur hirarki dari seluruh tampilan sistem yang dirancang 

yaitu menu-menu beserta sub menunya. 

 
 

Catatan : 

 

• Jika menggunakan UML (Unified Modeling Language), Diagram yang 

digunakan Use Case, Activity dan Class Diagram 

• Jika menggunakan UML, sub poinnya disesuaikan dengan kebutuhan 

penelitian 
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BAB IV 

 

HASIL DAN PEMBAHASAN 

 

 
 

Pada bab ini berisi hasil program yang dirancang dan hasil program harus 

sama dengan rancangan pada bab sebelumnya. 

 
4.1 Hasil 

 

Berisikan tampilan eksekusi program meliputi Menu, Form (input sistem) 

dan Report (output sistem) yang sudah berisikan data. 

 
4.1.1 Menu 

 

Pada bagian ini berisi tampilan menu sistem termasuk juga didalamnya 

submenu serta setiap menu yang ada dijelaskan fungsi pengunaannya. 

 
4.1.2 Masukan (Input) Sistem 

 

Pada bagian ini berisi formulir atau input screen dari masukan sistem, setiap 

input sistem harus dijelaskan fungsi penggunaannya dan kelebihannya. 

 
4.1.3 Keluaran (Output) Sistem 

 

Pada bagian ini berisikan Laporan atau output dari sistem, setiap output dan 

laporan harus dijelaskan fungsi penggunaannya dan kelebihannya 

 

4.2 Pembahasan 
 

Menjelaskan keterkaitan hasil berdasarkan metodologi dan kebenaran 

argumentasi dari landasan teoritis dalam memperoleh solusi pemecahan 

permasalahan. 
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4.2.1 Prosedur Kerja Sistem 

 

Pada bagian ini berisikan penjelasan mengenai bagaimana prosedur 

kerja dari sistem yang telah dibuat, termasuk juga didalamnya kontrol 

terhadap sistem dan data yang digunakan serta penjelasan lainnya. 

 
4.2.2 Spesifikasi Kebutuhan Sistem 

 

Berisi ketentuan spesifikasi kebutuhan implementasi mulai dari 

hardware, software atau teknologi lainnya yang akan digunakan 

 
4.2.3 Kelemahan dan Kelebihan Sistem 

 

Berisi penjelasan kelebihan dan kelemahan dari sistem yang dihasilkan 

sebagai rumusan pengembangan sistem. 
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BAB V 

KESIMPULAN DAN SARAN 

 

 

5.1 Kesimpulan 

 

Bagian ini menguraikan tentang hasil yang diperoleh dari proses penelitian 

yang dilakukan. Berikut ketentuan dari kesimpulan : 

1. Kesimpulan harus disesuaikan dengan rumusan masalah, yaitu berupa jawaban 

atas pertanyaan yang dirumuskan dalam penelitian. 

2. Kesimpulan juga memuat hasil temuan baru dari proses penelitian 

 
 

5.2 Saran 

 

Bagian ini berisi saran atau masukan yang membangun terhadap penelitian 

yang dilakukan. Berikut ketentuan dari saran : 

1. Saran yang diberikan disesuaikan dengan pada kelemahan sistem yang telah 

diidentifikasi untuk upaya perbaikan sistem. 

2. Saran juga memuat pengembangan dari batasan masalah pada penelitian yang 

diangkat. 
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Lanjutkan sesuai dengan referensi pada Tugas Akhir Anda 

 

 

Contoh Daftar Pustaka 
 
 

Bagian Akhir 
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BAB III 

 

 

 

 

 
SEKOLAH TINGGI MANAJEMEN INFORMATIKA DAN KOMPUTER 

TRIGUNA DHARMA 

M E D A N 

2 0 2 2 

Contoh Pembatas Bab 
 
 



55  

 

 
 

BAB I 

PENDAHULUAN 

 

 

 

1.1 Latar Belakang 

 

Bagian ini menguraikan tentang alasan penelitian dilakukan dengan 

mengemukakan permasalahan yang diteliti serta cara menyelesaikan permasalahan 

yang dianalisa. Berikut ketentuan dari latar belakang : 

1. Berisi tentang topik yang akan dibahas dalam Tugas Akhir, meliputi : Objek 

dari penelitian (kasus yang diangkat), gagasan atau kebaruan yang ingin 

ditemukan dan solusi yang ditawarkan. 

2. Deskripsi latar belakang adalah 2 sampai dengan 3 halaman. 

 

3. Menyertakan referensi (kutipan) dari penelitian sebelumnya untuk memperkuat 

gagasan atau kebaruan penelitian yang dikemukakan. 

4. Penggunaan referensi (kutipan) pada latar belakang adalah 2 sampai dengan 5 

referensi. Pada kutipan tersebut secara umum menjelaskan tentang (objek 

penelitian dan permasalahan 

5. Diakhir paragraf pada latar belakang harus mencantumkan judul yang diangkat 

 

dengan diberi tanda “ ”, dan bold dengan huruf kapital. 

 

“PENERAPAN SENSOR CAHAYA DALAM PEMBUATAN LAMPU TAMAN 

RUMAH OTOMATIS BERBASIS MIKROKONTROLLER” 

Bagian Isi Prodi Teknik Komputer 
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1.2 Rumusan Masalah 

 

Bagian ini memaparkan tentang point-point yang merujuk pada latar belakang 

dari penelitian yang diangkat untuk dapat diselesaikan dalam bentuk daftar 

pertanyaan. Berikut ketentuan dari rumusan masalah : 

1. Rumusan masalah dimulai dengan kata tanya yang perlu dijawab secara rinci 

dan jelas pada hasil penelitian. Seperti : Bagaimana, Mengapa atau Apakah. 

2. Pertanyaan penelitian harus relevan dengan topik penelitian yang dikaji. 

 

3. Pastikan bahwa rumusan masalah yang ditetapkan memiliki nilai penelitian, 

yang nantinya akan dibahas pada Bab III, IV dan V. 

 

1.3 Batasan Masalah 

 

Bagian ini menjelaskan tentang batasan atau cakupan permasalahan yang 

akan diselesaikan agar tidak meluas ke area permasalahan lainnya sehingga fokus 

penelitian dapat dilakukan dengan optimal. Berikut ketentuan dari batasan masalah : 

1. Tidak boleh mencantumkan nama produk software. 

 

2. Mencantumkan variabel atau kriteria yang digunakan dalam penelitian. 

 

3. Menjelaskan tentang data yang digunakan dalam penelitian, seperti : sumber, 

periode dan bentuk data. 

4. Mengemukakan model atau basis alat yang digunakan. Contoh : Berbasis 

Mikrokontroller, PLC dan lainnya 

 

1.4 Tujuan Penelitian 

 

Bagian ini berisi tentang tujuan yang akan hendak dicapai sesuai dengan 

rumusan masalah yang telah dibuat. Berikut ketentuan dari tujuan penelitian : 

1. Tujuan penelitian dimulai dengan kata “Untuk” yang bermakna sesuatu hasil 

yang akan diharapkan dari proses yang akan dilaksanakan. 
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2. Tujuan penelitian haruslah memiliki hubungan yang jelas dari masing-masing 

point pada rumusan masalah sehingga dapat diartikan tujuan merupakan solusi 

dari sebab akibat yang dituangkan pada rumusan masalah. 

 

1.5 Manfaat Penelitian 

 

Bagian ini berisi tentang dampak/pengaruh yang diperoleh dari penelitian 

yang dilakukan. Berikut ketentuan dari manfaat penelitian : 

1. Manfaat penelitian dimulai dengan kata “Dapat” yang bermakna manfaat dari 

hasil penelitian yang dilakukan. 

2. Manfaat penelitian minimal memiliki dampak/pengaruh terhadap ilmu 

pengetahuan dan sistem yang diterapkan. 
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BAB II 

LANDASAN TEORI 

 

 

2.1 Teori Tentang Kasus Yang Diangkat 

 

Berisi uraian singkat tentang bahan referensi yang digunakan sebagai 

metodologi dalam memecahkan permasalahan penelitian. 

Landasan teori berupa uraian-uraian teoritis yang hanya berkaitan dengan masalah 

yang diteliti. Landasan teori ini diperoleh dan dijabarkan dari acuan 

pustaka/studi pustaka yang digunakan dan disusun sendiri oleh mahasiswa untuk 

menyusun kerangka pengerjaan tugas akhir. 

Landasan teori berisi penjelasan tentang teori-teori yang digunakan dalam penulisan, 

meliputi : 

- Teori tentang bahan penelitian, temuan serta bahan penelitian yang diperoleh 

dari berbagai referensi. 

- Teori tentang aplikasi yang digunakan dalam proses penyelesaian 

kasus/sistem yang dirancang. 

- Rumus-rumus maupun tahapan-tahapan yang nantinya digunakan dalam 

proses penyelesaian kasus yang diangkat,. 

- Teori mengenai metode pengembangan sistem. 

 

- Teori tentang teknik dan cara analisa dan perancangan. 

 

- Teori mengenai diagram-diagram yang digunakan. 
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2.2 Gambaran Umum Perusahaan 

 

Penjelasan singkat tentang organisasi/perusahaan yang dianalisis, termasuk 

penjelasan tentang struktur organisasi dan job description. Pada tinjauan 

organisasi dijelaskan juga tujuan organisasi/perusahaan sehingga memudahkan 

dalam menganalisis proses bisnis yang dilakukan. 

Sesuaikan sub bab dengan landasan teoritis yang anda gunakan 
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BAB III 

 

ANALISA DAN PERANCANGAN 
 

 

 

 
 

3.1 Analisa 

 

Berisi uraian tentang analisa yang digunakan dalam memecahkan 

permasalahan penelitian. 

3.1.1 Blok Diagram Sistem 

 

Berisikan tentang gambar blok diagram dari sistem yang dirancang dimana 

menjelaskan dan menggambarkan keseluruhan komponen-komponen atau bagian- 

bagian yang mendukung agar rancangan sistem yang dibuat dapat bekerja secara 

keseluruhan. 

3.1.2 Algoritma Sistem 

 

Berisikan tentang tahapan-tahapan atau algoritma jalannya sistem yang akan 

dirancang mulai dari tahap awal hingga tahap akhir, sehingga diperoleh gambaran 

jelas mengenai cara kerja sistem yang dirancang. 

 
 

3.2 Perancangan 

 

Berisi uraian tentang perancangan yang digunakan dalam penyelesaian 

penelitian. 

3.2.1 Perancangan Model 

 

Berisikan tentang rancangan rangkaian perbagian serta rangkaian peralatan yang 

dirancang secara keseluruhan, juga berisikan gambar disain dari peralatan yang 

dirancang dalam tampilan disain 2D /3D 
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3.2.2 Flowchart Sistem 

 

Berisikan tentang gambar flowchart dari proses cara kerja alat yang dirancang serta 

penjelesan mengenai tahapan-tahapan proses kerjannya. 
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BAB IV 

 
HASIL DAN PENGUJIAN 

 

 

 
 

4.1 Hasil 
 

Pada sub bab ini ditampilkan dari gambar hasil dari sistem 

yang sudah selesai dirancang. Gambar hasil harus disesuaikan dengan 

perancangan pada Bab III. 

 

4.2 Pengujian Sistem 

 

Pada sub bab ini menunjukkan gambar hasil dari pengujian sistem 

yang dirancang yang harus sesuai dengan tujuan perancangan sistem 

tersebut. Dalam pengujian tersebut harus menunjukkan sistem bekerja 

dengan baik. 
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BAB V 

KESIMPULAN DAN SARAN 

 

5.1 Kesimpulan 

 

Yang diambil dari isi BAB III dan BAB IV dan harus konsisten 

dengan tujuan penulisan serta harus mencerminkan terpecahnya rumusan 

masalah yang dibahas di BAB I (kesimpulan harus sesuai dengan rumusan 

masalah yang diangkat). 

 

5.2 Saran 

 

Saran merupakan jabaran tentang usulan perbaikan kepada peneliti 

berikutnya ketika teridentifikasi hasil yang telah diperoleh masih memiliki 

kelemahan untuk diperbaiki dan disempurnakan dalam penelitian 

berikutnya. 
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LISTING PROGRAM 

 
4 Spasi 

 

MODUL KONEKSI 

imports System.Data.OleDb 

Module Module1 

'Public strcetak, parameter As String 

Public Cn As New OleDbConnection 

 

 

Sub Bukakoneksi() 

Cn.ConnectionString = "Provider=Microsoft.Jet.OLEDB.4.0;Data 

Source=" & Application.StartupPath & "\ta.mdb" 

Cn.Open() 

End Sub 

 
End Module 

 

 

Lanjutkan sesuai dengan Listing pada program Tugas Akhir Anda 

Contoh Listing Program 
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LAMPIRAN 

PANDUAN TUGAS 

AKHIR 
 

 

 

 

 
SEKOLAH TINGGI MANAJEMEN INFORMATIKA DAN KOMPUTER 

TRIGUNA DHARMA 

M E D A N 

2 0 2 2 
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SURAT PERMOHONAN TUGAS AKHIR 

 

 

Kepada Yth. : 
Ibu Astri Syahputri, S.Kom., M.Kom. 

Ketua Program Studi Manajemen Informatika / Teknik Komputer 

STMIK Triguna Dharma 
Di Tempat 

 
Dengan hormat, 

Saya yang bertanda tangan dibawah ini : 

Nama : 

NIRM : 

No. Telp/HP : 

Mengajukan permohonan Tugas Akhir kepada Bapak , dengan judul Tugas Akhir : 
 
 

Sebagai bahan pertimbangan, turut saya lampirkan berkas persyaratan sebagai 

berikut : 

1 Daftar Nilai Sementara (Validasi Biro Pengolahan Nilai) 

2 Fotocopy Bukti Pembayaran Uang Kuliah Cicilan Berjalan 

3 Ringkasan Judul Tugas Akhir 

4 Validasi SKPI 

Demikianlah Surat Permohonan ini saya perbuat, dengan harapan sudi kiranya Bapak 

dapat menyetujuinya dan atas perhatian serta persetujuan Bapak, saya ucapkan 

terima kasih. 

Medan,-------------- 2023 

Hormat saya, 
 

 

 

 

 

 

 

 

 
Nb. Pengajuan Judul dapat diserahkan ke Bag. Prodi 

Lampiran 1 

Surat Permohonan Tugas Akhir 
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RINGKASAN JUDUL TUGAS AKHIR 

 

 

Nama : 

NIRM : 

Kelas : 
 

 
Judul Tugas Akhir : 

Isi sesuai judul Tugas Akhir yang anda ajukan 

Ringkasan : 

 
 

Berisi tentang deskripsi dari Tugas Akhir anda, yang memuat alasan judul tersebut 
layak untuk diterima dan dijadikan penelitian 

Maksimal 250 kata 

Hasil : 

Ditolak / Diterima (Diisi oleh Kaprodi) 

 

 

 

 

 

Rekomendasi : Medan,-------------- 2023 

Dosen Peminatan Hormat saya, 
 

 

 

 

 

 
 

 

 

 
Nb. Jika ada rekomendasi dari Dosen Peminatan silahkan meminta tanda tangan 

dosen tersebut, namun jika tidak ada kosongkan saja. 

Lampiran 2 

Ringkasan Judul Tugas Akhir 
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Jl. AH. Nasution No. 73 Medan - Sumatera Utara. Telp. (061) 8224051 

Website : www.trigunadharma.ac.id E-mail : 

info@trigunadharma.ac.id 
 

SURAT KEPUTUSAN 

WAKIL KETUA I BIDANG AKADEMIK STMIK TRIGUNA DHARMA 

No : 1.5.019/STMIK-TGD/WK-I/MI/PPDP/I/2023 

Tentang 

PENETAPAN DAN PENGHUNJUKAN DOSEN PEMBIMBING 
TUGAS AKHIR 

PROGRAM STUDI MANAJEMEN INFORMATIKA (D-3) 

STMIK TRIGUNA DHARMA TA : 2023/2023 
 

Menimbang : a. Bahwa dalam rangka penyelesaian penyusunan Tugas Akhir setiap mahasiswa, 
ditugaskan untuk melakukan bimbingan; 

b. Bahwa pembimbing disesuaikan dengan beban dan bidang keilmuan dosen; 
c. Maka sehubungan dengan butir a dan b, perlu diterbitkan surat keputusan. 

 
Mengingat : a. Undang-undang Nomor 20 Tahun 2003 tentang Sistem Pendidikan Nasional; 

b. Peraturan Pemerintah Nomor 60 Tahun 1999 tentang Pendidikan Tinggi; 
c. Undang-undang Nomor 14 Tahun 2005 tentang Guru dan Dosen; 
d. Statuta Sekolah Tinggi Manajemen Informatika dan Komputer (STMIK) Triguna 

Dharma. 
 

MEMUTUSKAN 

Menetapkan : 

Pertama : Menugaskan nama dosen sebagai Pembimbing penyelesaian Tugas Akhir seperti 

pada Lampiran surat Keputusan ini; 
Kedua : Penugasan sebagai pembimbing dikoordinasikan oleh Wakil Ketua I Bidang 

Akademik terhadap Ketua Program Studi Manajemen Informatika Jenjang Diploma- 
3; 

Ketiga : Keputusan ini mulai berlaku sejak tanggal ditetapkan dan akan diperbaiki 
sebagaimana mestinya jika terdapat kekeliruan; 

Keempat :  Keputusan ini disampaikan kepada yang bersangkutan untuk dilaksanakan. 
 

Ditetapkan di : Medan 
Pada Tanggal : 10 Januari 2023 

WAKA I BIDANG AKADEMIK 
 

Dto 

 
 

Puji Sari Ramadhan,S.Kom., M.Kom 
NIDN : 0126039201 

 

Tembusan :    1. Ketua STMIK Triguna Dharma 
2. Wakil Ketua II Bidang Keuangan 
3. Arsip 

 

SK Dosen Pembimbing dapat diunduh pada halaman web : 

www.trigunadharma.ac.id 

Lampiran 3 

SK Dosen Pembimbing 

http://www.trigunadharma.ac.id/
mailto:info@trigunadharma.ac.id
http://www.trigunadharma.ac.id/
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LAMPIRAN KEPUTUSAN WAKIL KETUA I BIDANG AKADEMIK 

NOMOR : ……/STMIK-TGD/WK-I/MI/PPDP/I/2023 

TANGGAL : 2023 

PRODI : MANAJEMEN INFORMATIKA/TEKNIK KOMPUTER (D-3) 

 

 

 
NO 

DOSEN 

PEMBIMBING 

 
NIRM 

NAMA 

MAHASISWA 

JUDUL TUGAS 

AKHIR 

 

1 
    

 
2 

    

 

Informasi SK Dosen Pembimbing diumumkan secara bertahap di : 

www.trigunadharma.ac.id 

Lampiran 4 

Lampiran SK Dosen Pembimbing 

http://www.trigunadharma.ac.id/
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BERITA ACARA BIMBINGAN SKIRPSI 

 
 

Nama Mahasiswa :    

NIRM :    

Dosen Pembimbing :    
Judul Tugas Akhir :    

 

 

 
 

No 
Tanggal 

Pertemuan 

 

Topik Pembahasan 

 

Keterangan 
Paraf Dosen 

Pembimbing 

     

 

Medan, 2023 

Ketua Program Studi Dosen Pembimbing  

 

 

 

 

Astri Syahputri, S.Kom, M.Kom Nama Dosen Pembimbing 
 

 

Jika Lembar Bimbingan lebih dari 1 lembar, maka tanda tangan diletakkan di 

halaman terakhir 

Lampiran 5 

Berita Acara Bimbingan 
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SURAT PERMOHONAN 

SEMINAR PROPOSAL TUGAS AKHIR 

 

 

Kepada Yth. : 

Ibu Astri Syahputri, S.Kom., M.Kom. 

Ketua Program Studi Manajemen Informatika/Teknik Komputer* 

STMIK Triguna Dharma 

Di Tempat 

 
Dengan hormat, 

Saya yang bertanda tangan dibawah ini : 

Nama : 

NIRM : 

No. Telp/HP : 

Dengan ini mengajukan permohonan Seminar Proposal dan sebagai bahan 

pertimbangan, turut saya lampirkan berkas persyaratan sebagai berikut : 

1. Daftar Nilai Sementara (Validasi Biro Pengolahan Nilai) 

2. Fotocopy Bukti Pembayaran Uang Kuliah Cicilan Berjalan 

3. Fotocopy Bukti Pembayaran Uang Peminatan 

4. Fotocopy Bukti Pembayaran Uang Seminar Proposal 

5. Fotocopy Berita Acara Bimbingan (Accepted Bab I s.d III) 

6. Validasi SKPI Sementara 

Demikianlah Surat Permohonan ini saya perbuat, dengan harapan sudi kiranya Bapak 

dapat menyetujuinya dan atas perhatian serta persetujuan Bapak, saya ucapkan 

terima kasih. 

Medan,-------------- 2023 

Hormat saya, 
 

 

 

 

 

 

 

 

Nb. *Diketikan sesuai Program Studi 

Pengajuan Seminar Proposal dapat diserahkan ke BAAK 

Lampiran 6 

Surat Permohonan Seminar Proposal 
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SURAT PERMOHONAN 

SEMINAR HASIL TUGAS AKHIR 

 

 

Kepada Yth. : 

Ibu Astri Syahputri, S.Kom., M.Kom. 

Ketua Program Studi Manajemen Informatika/Teknik Komputer* 

STMIK Triguna Dharma 

Di Tempat 

 
Dengan hormat, 

Saya yang bertanda tangan dibawah ini : 

Nama : 

NIRM : 

No. Telp/HP : 

Dengan ini mengajukan permohonan Seminar Hasil dan sebagai bahan 

pertimbangan, turut saya lampirkan berkas persyaratan sebagai berikut : 

1. Daftar Nilai Sementara (Validasi Biro Pengolahan Nilai) 

2. Fotocopy Bukti Pembayaran Uang Kuliah Cicilan Berjalan 

3. Fotocopy Bukti Pembayaran Uang Seminar Hasil 

4. Fotocopy Berita Acara Bimbingan (Accepted All Draft Tugas Akhir) 

5. Pas Photo Hitam Putih 3x4 sebanyak 4 Lembar 

6. Fotocopy Form Revisi Seminar Proposal 

7. Bukti Cek Plagiat Tugas Akhir (Validasi Perpustakaan) 

Demikianlah Surat Permohonan ini saya perbuat, dengan harapan sudi kiranya Bapak 

dapat menyetujuinya dan atas perhatian serta persetujuan Bapak, saya ucapkan 

terima kasih. 

Medan,-------------- 2023 

Hormat saya, 
 

 

 

 

 
 

 

Nb. *Diketikan sesuai Program Studi 

Pengajuan Seminar Hasil dapat diserahkan ke BAAK 

Lampiran 7 

Surat Permohonan Seminar Hasil 
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SURAT PERMOHONAN 

SIDANG (UJIAN KOMPREHENSIF) TUGAS AKHIR 

 

 

Kepada Yth. : 
Ibu Astri Syahputri, S.Kom., M.Kom. 

Ketua Program Studi Manajemen Informatika/Teknik Komputer* 

STMIK Triguna Dharma 

Di Tempat 

 
Dengan hormat, 

Saya yang bertanda tangan dibawah ini : 

Nama : 

NIRM : 

No. Telp/HP : 

Dengan ini mengajukan permohonan Sidang (Ujian Komprehensif) dan sebagai 

bahan pertimbangan, turut saya lampirkan berkas persyaratan sebagai berikut : 

1. Daftar Nilai Sementara (Validasi Biro Pengolahan Nilai) 

2. Surat Keterangan Bebas Administrasi (Validasi Bagian Keuangan) 

3. Fotocopy Berita Acara Bimbingan (Accepted Ketua Program Studi) 

4. Fotocopy Form Revisi Seminar Hasil 

5. Surat Keterangan Ketua PRPM tentang HKI 

6. Validasi SKPI Sementara 

7. File (Ijazah SMA, KTP, Pas photo berwarna, Tugas Akhir dan Program) 

8. Bukti Serah Terima Sumbangan Buku (Validasi Perpustakaan) 

Demikianlah Surat Permohonan ini saya perbuat, dengan harapan sudi kiranya Bapak 

dapat menyetujuinya dan atas perhatian serta persetujuan Bapak, saya ucapkan 

terima kasih. 

Medan,-------------- 2023 

Hormat saya, 
 

 

 

 

 
 

 

Nb. *Diketikan sesuai Program Studi 

Pengajuan Sidang dapat diserahkan ke BAAK 

Lampiran 8 

Surat Permohonan Sidang 
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FORMULIR PERUBAHAN JUDUL TUGAS AKHIR 
 

 

 

Tanggal :  

Nama :     

NIRM :     

Telepon/HP :  

Judul Lama :     

 

Judul Baru :     

 

Alasan Perubahan Judul :     

 

 

 

Medan, 2023 

Saya yang bermohon, 

 

 

 

(Nama Mahasiswa) 
 

 

 

Disetujui Oleh : Diketahui Oleh : 

Pembimbing  Ketua Program Studi 

 

 

 

Nama Dosen Pembimbing  Astri Syahputri, S.Kom., M.Kom 

 

 

Nb. Pengajuan Perubahan Judul dapat diserahkan ke Bag. Prodi 

Lampiran 9 

Formulir Perubahan Judul 
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SURAT PERMOHONAN 

PERUBAHAN DOSEN PEMBIMBING 

 
 

Kepada Yth. : 

Ibu Astri Syahputri, S.Kom., M.Kom. 

Ketua Program Studi Manajemen Informatika/Teknik Komputer* 

STMIK Triguna Dharma 

Di Tempat 

 
Dengan hormat, 

Saya yang bertanda tangan dibawah ini : 

Nama : 

NIRM : 

Judul Tugas Akhir : 

Mengajukan permohonan perubahan dosen pembimbing Tugas Akhir saya, yaitu : 
 

Nama Dosen Pembimbing Alasan Pergantian 

 

(Isi nama dosen pembimbing yang ingin 
digantikan) 

 

(Isi Alasan pergantian dosen 
pembimbing) 

 

Demikianlah surat permohonan ini saya perbuat, harapan saya agar Bapak dapat 

menyetujuinya. 

Diketahui Medan, --------------- 2023 

Dosen Pembimbing Pemohon 

 

 

 

(Nama Dosen Pembimbing) (Nama Mahasiswa) 
 

 

Disetujui 

Ketua Program Studi Manajemen Informatika/Teknik Komputer* 

 

 

 

(Astri Syahputri, S.Kom, M.Kom) 
 

 

Nb. *Diketik sesuai program studi 

Pengajuan Perubahan Dosen Pembimbing dapat diserahkan ke Bag. Prodi 

Lampiran 10 

Surat Permohonan Perubahan Pembimbing 
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SEKOLAH TINGGI MANAJEMEN INFORMATIKA KOMPUTER 

TRIGUNA DHARMA 

SK. Mendiknas/Dikti No. 270/D/O/2002 - 212/D/O/2004 

 
 

 

.:: FORM REVISI SEMINAR PROPOSAL / HASIL TUGAS AKHIR ::. 
 

NIRM : 

Nama Mahasiswa : 

Jurusan : 

Judul Tugas Akhir : 

Pembimbing : 

 

NO. Keterangan Revisi 

  

 

Medan, 2023 

Dosen Pembimbing Dosen Pembanding 
 

 

 

 

 
 

 

 

 

Keterangan: 

- Pembanding menandatangani Form Revisi setelah dilakukan revisi oleh 

mahasiswa 

- Jika tidak ada revisi pembanding berhak langsung menandatangani Form 

Revisi 

- Form Revisi yang telah di tandatangani oleh pembanding wajib diserahkan 

kepada Kaprodi pada saat penyerahan Tugas Akhir/Tugas Akhir oleh 

Mahasiswa 

Lampiran 11 

Form Revisi Seminar Proposal / Hasil 
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BERITA ACARA 

SERAH TERIMA DRAFT TUGAS AKHIR 

SEMINAR PROPOSAL/HASIL 

 

Sehubungan dengan akan dilaksanakan Seminar Proposal/Hasil* pada tanggal 

  , dengan mahasiswa sebagai berikut : 

 

NIRM : 
Nama : 

Judul Tugas Akhir : 

 

Maka dengan ini diserahkan berkas Tugas Akhir yang telah dijilid kepada Bapak 

  , yang ditetapkan oleh Bagian Akademik sebagai Pembanding 

Seminar Proposal/Hasil*. 

 

Dengan serah terima ini maka Dosen Pembanding : 

 

1. Wajib memeriksa serta mengoreksi Tugas Akhir yang di susun sebelum 

seminar dilaksanakan. 

2. Mempersiapkan bahan diskusi yang akan menjadi masukan bagi mahasiswa 

terhadap Tugas Akhir yang di seminarkan. 
3. Wajib membawa berkas Tugas Akhir pada saat seminar dilaksanakan. 

 

Demikian tanda terima berkas Tugas Akhir ini dibuat berdasarkan keadaan yang 

sebenarnya untuk dapat di pergunakan sebagaimana mestinya. 

 

 

 

Medan, 2023 

Yang Menerima, Yang Menyerahkan, 

Dosen Pembanding,  Mahasiswa, 
 

 

 

 

 
 

Lampiran 12 

Form Serah Terima Draft Seminar 
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BUKTI TANDA TERIMA TUGAS AKHIR 
 
 

Nama Mahasiswa :  

NIRM :     

Program Studi :  

Judul Tugas Akhir :     

 

 

 

 

 
 

No 
Tanggal 

Penyerahan 

 

Yang Menerima Tugas Akhir 

 

Paraf/Stempel 

 
a1 

  
Pembimbing :    

 
Softcopy 

 
2 

  
Perpustakaan :    

 
Softcopy / 

Hardcopy 

 

 

 

Medan, 2023 

Ketua Program Studi MI/TK, 

 

 

 

 

 
Astri Syahputri, S.Kom.,M.Kom 

Lampiran 13 

Bukti Tanda Terima Tugas Akhir 
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SURAT PERMOHONAN 

SEMINAR / SIDANG ULANG 

 

 

Kepada Yth. : 

Ibu Astri Syahputri, S.Kom., M.Kom. 

Ketua Program Studi Manajemen Informatika/Teknik Komputer* 
STMIK Triguna Dharma 

Di Tempat 

 
Dengan hormat, 

Saya yang bertanda tangan dibawah ini : 

Nama : 

NIRM : 

No. Telp/HP : 

Dengan ini mengajukan permohonan Seminar / Sidang Ulang dan sebagai bahan 

pertimbangan, turut saya lampirkan berkas persyaratan sebagai berikut : 

1. Fotocopy Bukti Pembayaran Seminar/Sidang Ulang 

Demikianlah Surat Permohonan ini saya perbuat, dengan harapan sudi kiranya Bapak 

dapat menyetujuinya dan atas perhatian serta persetujuan Bapak, saya ucapkan 

terima kasih. 

Medan,-------------- 2023 

Hormat saya, 
 

 

 

 

 
 

 

Nb. *Diketik sesuai Program Studi 

Pengajuan dapat diserahkan ke BAAK 

  

Lampiran 14 

Surat Permohonan Seminar/Sidang Ulang 
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Lampiran 15 

BERITA ACARA PRA SIDANG 
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Lampiran 16 

BERITA ACARA PRA SIDANG 
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PENGGUNAAN PLAGIARIZM CHECKER 

PENGGUNAAN MENDELEY DAN 

TATA KELOLA DOKUMEN 
 

 

 

 

 
 

 

 

 

SEKOLAH TINGGI MANAJEMEN INFORMATIKA DAN KOMPUTER 

TRIGUNA DHARMA 

M E D A N 

2 0 2 3 
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PENGGUNAAN PLAGIARIZM CHECKER 

DALAM PENGECEKAN PLAGIASI TUGAS AKHIR 

 

 
1. Mahasiswa wajib mencetak hasil plagiasi Tugas Akhir menggunakan aplikasi 

Plagiarism Checker X untuk pendaftaran Seminar Hasil dengan persentase 

Plagiat Tugas Akhir (All Bab) ≤ 40%, disarankan agar pengecekan 

plagiasi/similarity dilakukan setiap BAB pada saat proses bimbingan. 

(institusi menyediakan aplikasi tersebut sebanyak 3 buah di perpustakaan) 

 
2. Panduan penggunaan aplikasi Plagiarism Checker X 

Berikut ini merupakan langkah-langkah penggunaan aplikasi Plagiarism 

Checker X dalam pengecekan draft Tugas Akhir : 

a. Membuka aplikasi Plagiarism Checker X 
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b. Pilih dan klik menu Online Plagiarism 
 

 
c. Pilih dan atur level plagiasi (Level 6) 
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d.  Kemudian masukkan dokumen yang akan dicek ke dalam Plagiarism 

Checker X, dengan mengklik tombol Load Document 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

e. Setelah dokumen dimasukkan, selanjutnya pilih tombol Analyze it 
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f. Hasil proses Analyze It akan terlihat sebagai berikut : 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

g. Kemudian setelah selesai proses Analyze It pilih tombol View Summary 
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PENGGUNAAN MENDELEY 

DALAM SITASI SKIRPSI 

 
 

1. Buka Aplikasi Mendeley, jika belum memiliki aplikasi tersebut maka dapat 

didownload melalui website : www.mendeley.com 

 
2. Kemudian masukkan file referensi yang akan dimasukkan, melalui File ➔ Add 

Files. 

3. Selanjutnya pilih file yang akan dimasukkan. 

http://www.mendeley.com/
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4. Setelah file masuk ke dalam aplikasi mendeley, maka selanjutnya menuju ke 

Microsoft Word, kemudian pilih References ➔ Insert Citation. 
 

5. Jika plug in mendeley tidak ada pada aplikasi Microsoft Word, maka aktifkan 

plug in di mendeley pada menu Tools ➔ Install Plugin Ms Word 
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6. Pilih Go to Mendeley, kemudian pilih referensi yang akan digunakan dalam 

Tugas Akhir, kemudian klik Cite. 
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TATA KELOA DOKUMEN 

PENGATURAN KERTAS DAN SPASI 

 
 

1. Pengaturan dokumen dapat melalui menu Page Layout ➔ Margin ➔ Costume 

Margin. 

 
 

2. Kemudian atur dokumen dengan contoh sebagai berikut : Top : 4 cm, Left : 4 

cm, Right : 3 cm, Bottom : 3 cm dan Paper : A4. 

 

3. Setelah selesai kemudian klik OK. 
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BAB I 

PENDAHULUAN | 

4. Pastikan semua dokumen diatur secara default (spasi 2) atau dengan menekan 

Ctrl 2. Dengan memilih menu Home ➔ Line Spacing. 
 

5. Pastikan Spacing paragraf 0 pt, dengan memilih menu Page Layout ➔ Paragraf. 

 

6. Jika Anda ingin mengubah spasi, maka letakkan kursor di kalimat terakhir 

paragraf sebelum spasi yang diinginkan. 

Contoh : 

 

 

7. Setelah itu pilih spasi yang diinginkan, misalnya spasi 4. Kemudian setelah 

diatur maka selanjutnya Enter. 

 


